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READ CAREFULLY BEFORE USING

Canon Software License Agreement
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX.  BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.
This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE
DATA) AND THE USER MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE”) AND
PROMPTLY RETURN THE SOFTWARE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.
1. LICENSE:  Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a

single computer.  You may physically transfer the SOFTWARE from one computer to another
provided that the SOFTWARE is used on only one computer at a time.  You shall not install or
use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other
hardware configuration where the SOFTWARE is accessible to more than one CPU or to more
than one user.
With respect to the sound and image data (“Data”) contained in the Software, which are to
be downloaded to the applicable Canon digital camera product, Canon grants you a personal,
non-exclusive license to use the Data on a single Canon digital camera product only.
YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE
USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING
LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN
WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes.  Any other copying of the SOFTWARE is a
violation of this Agreement.  You must reproduce and include the copyright notice on the
back-up copy.

3. SUPPORT AND UPDATES:  Neither Canon, nor its subsidiaries, dealers or distributors will be
responsible for providing maintenance or support for use of the SOFTWARE.  No updates, fixes
or support will be made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose,
maintain and match the hardware and software components of your computer system.  Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions
or performance of the SOFTWARE will meet your requirements.  THE SOFTWARE IS LICENSED
ON AN “AS IS” BASIS AND WITHOUT WARRANTY OR CONDITION OF ANY KIND. The CD-
ROM storing the SOFTWARE is warranted only against defective material under normal use for
a period of ninety (90) days after purchase from an authorized Canon dealer as evidenced by
your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same
without charge when returned by you at your expense to your point of purchase and proven
to be defective upon inspection.  The Replacement CD-ROM will be warranted for the
remainder of the original ninety (90) day warranty period of the defective CD-ROM.  The
limited warranty does not apply if the failure of the CD-ROM resulted from accident, abuse or
misapplication of the SOFTWARE and shall not extend to anyone other than the original user
of the SOFTWARE.
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EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR
CONDITIONS, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OR CONDITION OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE
SOFTWARE.
NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF
THE SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION
OF IMPLIED WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH
RESULTING FROM NEGLIGENCE ON THE PART OF THE SELLER, SO THE ABOVE
DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY TO YOU.

5. TERM:  This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated.  You may
terminate this Agreement by destroying the SOFTWARE.  This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you
must then promptly return the SOFTWARE.  In addition, Canon may enforce its other legal
rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:
The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995),
consisting of “commercial computer software” and “commercial computer software
documentation,” as such terms are used in 48 C.F.R. 12.212 (Sept 1995).  Consistent with 48
C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.72024 (June 1995), all U.S. Government
End Users shall acquire the SOFTWARE with only those rights set forth herein.  Manufacturer is
Canon Inc./30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501, Japan.

7. EXPORT RESTRICTIONS:  You agree to comply with all export laws and restrictions and
regulations of the country involved, and not to export or re-export, directly or indirectly, the
SOFTWARE in violation of any such laws and restrictions and regulations, or without all
necessary approvals.

8. SEVERABILITY:
In the event that any provision of this Agreement is declared or found to be illegal by any court
or tribunal of competent jurisdiction, such provision shall be null and void with respect to the
jurisdiction of that court or tribunal and all the remaining provisions of this Agreement shall
remain in full force and effect.

9. CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the Software
in the United States of America shall be governed and construed in all respects in accordance
with the laws and regulations of the State of New York, without reference to choice of law
principles.  The terms of this Agreement as it relates to purchases of the Software in Canada
shall be governed by the laws of the province of Ontario.
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10.OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors.  Your use of
the SOFTWARE is subject to the laws of the United States, and Canada, and other applicable
copyright and trademark laws, and nothing in this Agreement constitutes a waiver of the
rights of Canon, its affiliated corporations and third party licensors under such laws.  You only
own the CD-ROM media in which the Software is stored.  Except as expressly provided herein,
no license or right, express or implied, is hereby conveyed or granted by Canon to you for any
intellectual property of Canon.  Nothing contained in Paragraph 1 shall be construed to give
Canon any ownership rights in any images, graphics or textual material that you save in
connection with the Software.
You may not modify, remove or delete any or all copyright notices (i) which are contained in
the Software, including any copy thereof, and (ii) which are on the original CD-ROM and on
the medium of a back-up copy made pursuant to Section 2 above.

11.ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR
PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF.  NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Disclaimer
• While every effort has been made to ensure that the information contained in

this guide is accurate and complete, no liability can be accepted for any errors
or omissions. Canon reserves the right to change the specifications of the
hardware and software described herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means,
without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data
due to mistaken operation or malfunction of the camcorder, the software,
memory cards (MultiMediaCards or SD Memory Cards), personal computers,
or peripheral devices, or due to use of a memory card not formatted by a
Canon camcorder.

Trademark Acknowledgments
• Canon is a registered trademark of Canon Inc.
• Macintosh and Mac OS are trademarks of Apple Computer Inc., registered in

the United States and other countries.
iPhoto and QuickTime are trademarks of Apple Computer, Inc.

• Microsoft® and Windows® are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

• Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.

Copyright © Canon Inc. 2004 All rights reserved.

Safety Precautions
Do not play the supplied CD-ROM(s) in any CD player that does not support
data CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player)
could damage the speakers. It is also possible to suffer from hearing loss from
listening with headphones to the loud sounds of a CD-ROM played on a music
CD player.

Read This First
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Checking Supplied Accessories
Use the following accessories to download recorded images from a memory
card to your computer.
• IFC-300PCU USB Cable

• DIGITAL VIDEO SOLUTION DISK For Windows
• DIGITAL VIDEO SOLUTION DISK For Macintosh

• Windows users: Move on to p. 10.
• Macintosh users: Move on to p. 86.

The explanations in this manual use mainly Windows XP and Mac OS X
version10.2 screen shots.
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Windows  System Requirements

Please install the software on a computer meeting the following minimum
requirements.

OS: Windows 98 (First or Second Edition)
Windows Me
Windows 2000
Windows XP (Home Edition, Professional)
*Proper operation is not guaranteed on an OS that

has been upgraded from a previous version.
Computer Model: Computers that come with above OS preinstalled and

have built-in USB ports.
CPU: Windows 98/Windows Me/Windows 2000: Pentium

150 MHz or better
Windows XP: Pentium 300 MHz or better

RAM: Windows 98/Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more

Interface: USB: only preinstalled Windows 98/Windows Me/
Windows 2000/Windows XP systems with built-in USB
ports

Free Hard Disk Space: • Canon Utilities
– ZoomBrowser EX: 200 MB or more  (Including the

PhotoRecord printing program)
– PhotoStitch: 40 MB or more

• DV TWAIN Driver: 25 MB or more
• DV WIA Driver: 25 MB or more

Display: 800 × 600 pixels/High Color (16 bit) or better,
1,024 × 768 pixels or better is recommended

❍ The USB interface is only supported for those computers that come
with Windows 98/Windows Me/Windows 2000/Windows XP
preinstalled and have built-in USB ports.

❍ Proper operation is not guaranteed on a dual CPU PC or on a user-built
PC.

❍ Proper operation is not guaranteed on any particular system, even if it
meets the requirements outlined above.

❍ A CD-ROM drive is required to install the software.
❍ Connect the USB cable directly to one of the computer’s main USB

ports. The interface may not function correctly if the camcorder is
connected via a USB hub.



W
in

d
o

w
s

11

E
❍ The connection may not operate correctly if you are using other USB

devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

❍ Do not connect two or more camcorders to the same computer via the
USB interface. The connections may not operate correctly.

❍ Not all operations performed with a connection to a USB 2.0
compatible board can be guaranteed.
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What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained on
the DIGITAL VIDEO SOLUTION DISK For Windows.

■ TWAIN Driver (  17)
TWAIN Driver is the driver software for Windows 98 and Windows 2000 that
is required for downloading images from a memory card to a computer.

■ WIA Driver (  18)
WIA Driver is the driver software for Windows Me that is required for
downloading images from a memory card to a computer.

■ ZoomBrowser EX (  21)
• Downloading images from a memory card to your computer.
• Categorizing and organizing large volumes of images.
• Creating mail attachments from still images. (Your e-mail software needs

to be enabled as MAPI client.)

■ PhotoRecord (  47)
• Laying out and printing still images.
• Printing indexes.
• Creating still image albums.

■ PhotoStitch (  52)
Merging panoramic images.

This instruction manual explains how to install the software, what you can do
with the main features and how to operate them. For more detailed operational
instructions, refer to the Help menu of each software program.
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Installing the Digital Video Software

❍ Before you connect the camcorder to the computer with the USB cable
for the first time, you must install one of the following drivers onto the
computer.
Windows 98/Windows 2000: TWAIN Driver (  17)
Windows Me: WIA Driver (  18)

❍ Users of Windows 2000 or Windows XP must first log in as an
Administrator to install programs.

Windows XP Users:
Your digital video camcorder is equipped with the standard Picture
Transfer Protocol (PTP). This protocol enables you to download images by
simply connecting the camcorder to a computer with the USB cable (the
software such as the [Scanner and Camera Wizard] starts automatically).
However, please note that there are several limitations to downloading
images with this method. To avoid these problems, install ZoomBrowser
EX to download images.
❍ It may take a few minutes, after connecting the camcorder, until you

can download images.
❍ Images protected on the camcorder may lose this setting once they are

downloaded to the computer.

1. Close any programs that are running.

2. Set the DIGITAL VIDEO SOLUTION DISK For Windows in the
computer’s CD-ROM drive.
• The installer panel opens automatically.
• If the installer panel does not appear automatically, use the following

procedures to display it.
Windows 98, Windows Me, Windows 2000:

1. Double-click the [My Computer] icon.
2. Right-click the CD-ROM icon and select [Open] from the displayed

menu.
3. Double-click the [Setup.exe] icon.

Installing the Software
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Windows XP:
1. Select [My Computer] from the [Start] menu.
1. Right-click the CD-ROM icon and select [Open] from the displayed

menu.
3. Double-click the [Setup.exe] icon.

Depending on the setting of your computer, the file extension “.exe” may
not appear.

3. Select your language.

4. Click [Digital Video Software Installation].
For details about the DV Network Software, refer to the DV Network
Software Instruction Manual.

5. Click [Next].

6. Select your country/region and click [Next].

Installer Panel

Installing the Software
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7. Read the license agreement and click [Yes].

8. Confirm the installation destination and click [Next].
Normally, select (C:\Program Files\Canon\).

9. Select the programs you wish to install and click [Next].
• Confirm that there is a check mark beside the name of the program you

wish to install.
• Windows 98/Windows 2000/Windows Me: The respective USB driver

appears.
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10.Review the installation settings and click [Next].
• Installation starts.
• If the “Digital signature not found” message appears, click [Yes].

• When the following window appears, click [OK]. This window only
appears if you installed the TWAIN Driver or the WIA Driver.

11.When installation is complete, select [Yes, I want to restart
my computer now.] and click [Finish].

12.When the computer has restarted and the regular desktop
screen is displayed, remove the DIGITAL VIDEO SOLUTION
DISK For Windows from the CD-ROM drive.

Installing the Software
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Installing the TWAIN Driver/WIA Driver
Windows 98/Windows 2000/Windows Me: When you have installed the Digital
Video Software, go on to install the TWAIN Driver or the WIA Driver. Users of
Windows XP do not need to install a driver.

TWAIN Driver
TWAIN Driver is the driver software for USB connection to Windows 98 and
Windows 2000 that is required to download images into ZoomBrowser EX.

Users of Windows 2000 must first log in as an Administrator to install the
driver.

1. Insert a memory card containing images into the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  19).
• If the “Digital signature not found” message appears, click [Yes].
• After a few moments, a message such as “New Hardware Found”

appears and the TWAIN driver will be installed automatically.
• If you are prompted to restart the computer, restart the computer.
• When installation is complete, a window appears allowing you to select

an application program to start.
See Downloading Images (  21) for how to start ZoomBrowser EX and
download images to the computer.

Windows 98/Windows 2000

❍ When installation is complete, remove the DIGITAL VIDEO SOLUTION
DISK For Windows before you connect the camcorder to the computer.

❍ Windows 98/Windows 2000/Windows Me: At this point, the files for
the TWAIN Driver or WIA Driver have only been copied to your
computer. To download images via USB connection, finish installing
the TWAIN Driver or the WIA driver.
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WIA (Windows Image Acquisition) Driver
WIA Driver is the driver software for USB connection to Windows Me that is
required to download images into ZoomBrowser EX.

Read carefully before installing the WIA Driver:
When you have set the WIA Driver to start a particular application
program when you connect the camcorder, the program may cause an
error message similar to the following to appear: “TWAIN data source not
found. Reinstall the scanner software.” If this happens, select [WIA-
camera model] in the application program as the TWAIN device.

1. Insert a memory card containing images into the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  19).
• If the “Digital signature not found” message appears, click [Yes].
• After a few moments, a message such as “Found New Hardware”

appears and the WIA driver will be installed.
• If you are prompted to restart the computer, restart the computer.
• When installation is complete, the Scanners and Cameras Wizard starts.

See Downloading Images (  21) for how to start ZoomBrowser EX and
download images to the computer.

Windows Me

Installing the Software
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❍ Make sure the camcorder is being powered using the power adapter

before connecting it to a computer.
❍ Be sure to install the Digital Video Software before you connect the

camcorder to the computer.
❍ Connect the USB cable directly to one of the computer’s main USB

ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

❍ The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

❍ Do not connect two or more camcorders to the same computer via the
USB interface. The connections may not operate correctly.

❍ Never allow the computer to go into standby (sleep) mode while a
camcorder is connected via the USB interface. If it does happen,
never disconnect the USB cable. Try to awaken the computer with
the camcorder in the connected state. Some computers will not
awaken properly if you disconnect the camcorder while they are in
standby mode. Please refer to your computer manual for
instructions regarding its standby mode.

1. Insert a memory card containing images into the camcorder.

2. Connect the power adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
• If the “Digital signature not found” message appears, click [Yes].
• Refer to your computer manual for the location of the computer’s USB

ports.
• See your camcorder instruction manual for connecting instructions.

Connecting the Camcorder to a Computer
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USB Cable

Camcorder End Computer End

USB Terminal
on the Camcorder

USB Port on 
the Computer

❍ Windows 98/Windows 2000/Windows Me: The first time you connect
the camcorder to the computer via USB interface, install the TWAIN
Driver or the WIA Driver (  17,18).

❍ Windows XP: If a window appears prompting you to select an
application program to start, select ZoomBrowser EX or Scanners and
Cameras Wizard to start. If neither of these is selected, operation may
not work correctly. You can also set the computer to start
ZoomBrowser EX or Scanners and Cameras Wizard automatically
(  72).

Connecting the Camcorder to a Computer
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Below explains the procedure for connecting a camcorder to a computer using
the USB cable. For connecting a PC card reader/writer, see Using a PC Card
Reader/Writer (  26).

❍ Observe following precautions when the camcorder’s card access
indicator is flashing (the camcorder is reading or writing from or to the
memory card). Failure to do so may cause memory card data to
become corrupted.

–  Do not open the memory card cover, remove the memory card or
detach the USB cable.

–  Do not turn off the camcorder or the computer.
–  Do not change the position of the POWER switch or the TAPE/

CARD switch.
❍ Format the memory card with the camcorder or from the Camera

Settings Window (  29).
❍ Images recorded onto the memory card or downloaded to the hard

disk are important original data files. Create a copy of the file first
before working on it on your computer.

❍ For Windows XP Users:
• Do not rotate the image in the [Windows Picture and Fax Viewer]

or in the explorer view. The file format of the original image will be
changed and the image can no longer be displayed in
ZoomBrowser EX or on the camcorder.

• If the Server Busy window appears when you connect the
camcorder to the computer, click [Retry].

❍ You cannot connect the camcorder to a computer if the memory card
contains more than 1800 images. For best performance, we
recommend keeping the number of images on the memory card below
100 when downloading still images to the computer.

Downloading Images (ZoomBrowser EX)
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Downloading Images (ZoomBrowser EX)

Starting ZoomBrowser EX

1. Insert a memory card containing images into the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  19).
• After a few moments, a window appears allowing you to select an

application program to start.
• Windows XP: If the window does not appear or if “PC CONNECT” does

not appear on the camcorder screen, start ZoomBrowser EX and open the
Camera Window following the steps 5 to 7 for Windows Me.

5. Select [Canon ZoomBrowser EX] and click [OK].

• ZoomBrowser EX starts.
• With Windows 2000, the name of the application program may not

appear on the Canon Camera event window. In such case, double-click
the [ZoomBrowser EX] icon on the desktop to start ZoomBrowser EX.

• If a camcorder and PC card reader are connected at the same time, a
window appears allowing you to select the camcorder model. Confirm that
[Canon Camera] or your camcorder model name is displayed and click [OK].

Windows 98/Windows 2000/Windows XP
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E6. Click [Browse Images].

The Camera Window opens, displaying the camcorder images as
thumbnails (small images).

For instructions on how to set the Auto-download settings, see page 76.

1. Insert a memory card containing images into the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  19).
The Scanners and Cameras Wizard automatically opens. Click [Cancel] to
close the Wizard.

5. Double-click the [ZoomBrowser EX] icon on the desktop.
ZoomBrowser EX starts and the Main Window appears.

Windows Me
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6. Click [Camera & Memory Card] in the Main Window.

7. Click [Browse and Download Images].

8. Click  [Browse Images].

The Camera Window opens, displaying the camcorder images as
thumbnails (small images).

For instructions on how to set the Auto-download settings, see page 76.

Downloading Images (ZoomBrowser EX)
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Downloading Images to the Computer

1. In the Camera Window, select the image you wish to
download and click [Download image].
• An orange frame appears around the selected image.
• You can select multiple images by continuously clicking on the images.

Click on the image again to deselect.

2. In the Download Settings window, confirm the settings and
click [OK] (  29).
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Using a PC Card Reader/Writer
The basic operations of ZoomBrowser EX are the same as when you connect the
camcorder to the computer. Follow the procedure below to open the Camera
Window.
For instruction on how to connect the PC Card Reader/Writer, please refer to its
manual.

1. Insert a memory card containing images recorded with the
camcorder into the reader.

2. Windows 98/Windows 2000/Windows Me: Double-click the
[ZoomBrowser EX] icon on the desktop.

Windows XP: When a window appears allowing you to select
an application program to start, select [ZoomBrowser EX] and
click [OK].
ZoomBrowser EX starts. Move on to the step 5.

Downloading Images (ZoomBrowser EX)

The Camera Window closes and the Main Window opens. The downloaded
images appear in the Main Window.
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3. Click [Camera & Memory Card].

4. Click [Browse & Download Images].
If multiple PC card readers loaded with memory cards are connected or if a
camcorder and a PC card reader are connected, a selection dialog will
appear before the [Download image] window opens. Select one of the
devices to proceed and click [OK].

5. Click  [Browse Images].

The Camera Window opens, displaying the camcorder images as
thumbnails (small images).
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Using Other ZoomBrowser EX Functions

Camera Window
The Camera Window opens when a connection to a camcorder is initiated.
Images will be displayed as thumbnails (small images). Movies are displayed with
the first scene as a still image, indicated with a movie icon. Buttons are activated
when an image is selected.

Task Area

[Download image]: Downloads selected images to the computer.
[Print]: Prints selected still images. Menu options: Layout Print

and Contact Sheet Print.
[View as slideshow]: Starts a slide show after downloading the selected still

images to the computer.
[Connect to Internet]: Attaches selected still images to an e-mail message.

Toolbar

[Set]: Adjusts the connection settings and camcorder settings. Menu
options: Reconnect, Camera Settings, Slide*/DPOF, Add Image(s)
and My Camera. (*The Slide function cannot be used.)

[Select]: Selects images. Menu options: Select All, Select New, Select
Print mark, Select Send mark, Select Slide Show mark and
Invert Selection.

[Deselect]: Deselects images.
[Rotate]: Rotates still images. Menu options: 90 degree left, 90 degree

right and 180 degree.
[Delete]: Deletes selected images.
[Properties]: Displays image information (such as shooting date/time and

image size).
[Help]: Displays help topics.

Thumbnails
Images are displayed 
in reduced size.

Indicates that it has been 
downloaded to a computer.

Task Area Toolbar Movie icon
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Camera Settings Window
You can adjust the date, time and owner settings in the Camera Settings
window using the computer when the camcorder is connected. You can also
check the battery charge and remaining memory card capacity.

1. In the Camera Window, click the [Set] button and select [Camera Settings]
from the displayed menu.

2. Check or change the settings.
Click [OK] to close the window.

Download Settings Window
The following window appears when you select a task in the Task Area of the
Camera Window.

Select a folder in which you wish to 
download and save the image.

If you wish to create a new folder, select 
[Create new folder] and select the item 
you wish to use as folder name.

If you leave this box without check 
mark, the images will be named in the 
form of "IMG_XXXX.JPG".
If you place a check mark in this box, 
you can designate a file prefix. The 
images will be named "file prefix + 
XXXX.JPG".

Input a camcorder owner name here 
(up to 31 characters).

Set the date and time here.

Click this button to synchronize the 
camcorder to the computer s date 
and time settings.

Check the power status here.

Click this button to format the memory 
card in the camcorder. 

Check the remaining memory card 
capacity here.
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Using Other ZoomBrowser EX Functions

Main Window
ZoomBrowser EX's Main Window features various buttons and an image display
area. This section introduces the names and functions of the various window
parts.

Task Area (Main Menu)

[Camera & Memory Card]: Displays the Camera Window.
[Print]: Prints selected still images. Menu options: Layout

Print and Contact Sheet Print
[View & Modify]: Use this to view or edit images. Menu options:

View as a Slide Show, Export Images, Edit Image,
Stich Photos, Search and Backup to CD.

[Internet]: Attaches selected still images to an e-mail
message.

Clicking      hides the area. 
Click     again to redisplay the area.

Toolbar

Task Area Folders Area
Select image folders here. As in 
Windows Explorer, you can view the 
contents of the folders.

Browser Area
Displays the images 
contained in the 
selected folder.
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Toolbar

[View Mode]: Selects the view mode. Menu options:  Scroll Mode, Zoom
Mode and Preview Mode.
Scroll Mode:
Displays the images in the selected folder at a large, easy-to-
view size. When there are more images than can fit in the
Browser Area, a scroll bar appears at the right of the
Browser Area. When a folder has been created within the
selected folder, the folder appears as an icon.
Zoom Mode:
When a folder has been created within a folder, it displays all
images within the nestled folder. Selecting the magnifying
glass (+ or –) and clicking a folder or an image in the Browser
Area changes the size at which an image is displayed or the
folder level. You can also zoom up by double-clicking an
empty part of the Browser Area or the tab of a folder name.
Preview Mode:
Displays one image at a large size. You can review file name,
comment, histogram and image information. Select the
preview image from the bottom of the Main Window, or by
clicking [Previous] or [Next].

[Thumbnail Size]: Selects the size at which images are displayed in the Browser
Area. Menu options: 80 × 80, 160 × 160 and Column Number.
It can only be selected in [Scroll Mode].

[View Image]: Displays a still image in the Image Viewer window, or
opens a window for playing back a movie.

[Properties]: Displays image information (such as shooting date/time
and image size).
If you select an image in the Browser Area while the
Properties window is open, the information in the window
switches to the contents of the selected image.
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[Rotate]: Rotates selected still images.
[Delete]: Deletes selected images.

Switch between images with 
this button when more than 
one image is selected.

You can change the file name 
or enter a comment.

Using Other ZoomBrowser EX Functions
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Image Viewer Window
The Image Viewer window appears when you double-click a still image, or when
you select a still image and click [View Image].

Color, Brightness and Contrast
You can adjust the color, 
brightness and contrast by 
dragging the respective slide.

Zoom
You can change 
the zoom ratio.

Crop
You can extract a part of the still image.
1. Click on the still image and drag to form a rectangular frame. 

You can move or change the size of the frame.
2. Click this button to extract the area within the frame. 

The extracted part of the still image appears. 
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Playing Back Movies From a Memory Card

In the Camera Window and Main Window, movies are displayed with the first
scene as a still image with a movie icon (  ). When you double-click the
thumbnail in the Main Window, QuickTime Player starts and plays back the movie.

❍ If QuickTime 3.0 or a later version is not already installed on your
computer, install the QuickTime from the DIGITAL VIDEO SOLUTION
DISK. Place the disk in the CD-ROM drive and click [QuickTime
Installation] in the installer panel.

❍ Do not double-click a movie file (.AVI extension) in Windows Explorer.
That will start Windows Media Player, which may not support this file
type. To play back movies, double-click the thumbnail with a movie
icon in the Main Window’s Browser Area.

1. In the Main Window, double-click a thumbnail with a 
(movie) icon.
QuickTime Player starts.
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2. Click the e (play) button in QuickTime Player.

The movie will be played back.
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You can view selected still images in a slide show. Movies cannot be selected for
a slide show.

1. Click [View & Modify] in the Main Window.

2. Click [View as a Slide Show].

3. Select the images and click [Setup Slide Show].

Running a Slide Show
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4. Select the slide show settings.

• [Image Size]: Select the size of the still images.
• [Image Information]: Select to show image information such as file name

or title.
• [Advance to Next Slide]: Select to advance manually or automatically.

When you select “Every 3 seconds”, you can select the interval in the
control below (from 1 to 120 seconds).

• [Loop]: Select to stop the slide show after the last image or to
continuously run it in a loop.

• [Effect]: Select the transition effect to be used when moving from one
slide to another. When you click an effect, you can check the effect in the
preview window.

5. Click [Start Slide Show].
Click  in the lower right corner to end the slide show.
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You can search for images marked as your Favorites or by modification date,
shooting date or keywords. You can mark images as Favorites (  41) and add
keywords (  41).

Searching Images

1. Click [View & Modify] in the Main Window.

2. Select the folder in which you wish to search for the image
and click [Search].

Searching Images



W
in

d
o

w
s

39

E
3 Specify the search conditions.

• Place a check mark beside the parameter you wish to use.
• If you selected [Modification Date] or [Shooting Date], set the date range.

If you selected [Keywords], select the keywords.

4. Click [Start Search].
The images matching the conditions will be displayed.

Clicking here hides the search parameter details.
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5. Click [Finish].
To change the search parameters and perform another search, click [Specify
Search Condition] and repeat steps 3-4.

The images of the search result are displayed in the [Search Results] folder.
You can print or copy these images to another folder. The images will
remain in this folder until ZoomBrowser EX is closed or another search is
performed.

Searching Images
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Setting Parameters for Future Searches
In Preview Mode, you can mark images as Favorites, and open the [View/Modify
Keywords] window by clicking [View/Modify Keywords] in the Main Window.

Making an Image as Favorite

1. Select an image in the Browser Area and click  (Properties).

2. Place a check mark beside [Favorite Photo] and close the
[Properties] window.
The symbol shown below is displayed on images marked as Favorites

Adding Keywords to Images

1. Select an image in the Browser Area and click  (Properties).

Favorites Symbol
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2. Click [View/Modify Keywords].
You can also select [View/Modify Keywords] from the [Tools] menu.

3. Place a check mark beside the keyword you wish to use and
click [OK].

You can add and delete keywords. Open the Manage keywords window
by selecting [Manage keywords] from the [Tools] menu.

Searching Images

Place a check mark 
beside the keyword 
you wish to use.

To add a keyword, type the new word in the box and click [+].
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Adding Sound to an Image

You can add a sound to an image. The sound file needs to be in WAVE format
(extension “.wav”) or in MIDI format (extension “.mid” or “.midi”).
The sound cannot be played back on the camcorder.

Adding Sound to an Image

1. In the Main Window, select an image and select [Add/
Remove Sound] from the [Edit] menu.
The Sound window appears.

2. Click [Add].
A window appears allowing you to select a file.

3. Select the sound file and click [Open].

4. Click [OK].

•  appears on the image.
• The sound file will be copied to the same folder as the image.

To remove sound from an image, select [Remove] on the Sound Window

in step 2.  disappears and the copied sound file will be deleted.

Playing Back the Sound

In the Main Window, select the image with the sound
attachment and select [Play Sound] from the [Edit] menu.
The Play Sound window appears and the sound will be played back.
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Attaching Still Images to E-mail Messages

You can attach selected still images to an E-mail message.

To use this function, the e-mail software must be enabled as MAPI client.
For details, refer to the instruction manual of the e-mail software.

1. Click [Internet] in the Main Window.

2. Click [Email Images].
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3. Select the still images you wish to send and click [Change

Image Size].
You can select multiple still images by continuously clicking on the still
images. Click on the still image again to deselect.

4. Select image size and quality, and click [Send or Save].
• If you wish to send the still image without changes, select [Send images

unchanged]. Normally select [Resize and compress images into JPEG
format].

• [Resize Image]: Select the reduction ratio to the original still image.
• [Image quality]: The lower the quality, the coarser becomes the still image

and smaller the file size.
• Pressing [Apply] displays the file size after the compression as [Total size of

changed images].
• You can check the compressed still image by pressing [View Images].
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Attaching Still Images to E-mail Messages

5. Select to send still images by e-mail or to save the still images
in a folder and click [Finish].
• If you selected [Create a new email], your e-mail software starts and the

selected still images appear as an attachment in the message window.
Input address, subject and your comments and send the message. E-mail
software not supporting MAPI does not start automatically. In this case,
select [Save the images in a folder...].

• If you select [Save the images in a folder...], click [Browse] and select the
destination folder. Start your e-mail software and attach the saved still
image to a message.
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PhotoRecord is a printing program. You can use this program to lay out the still
images for printing. You can also create original albums and save them to your
computer. Movies cannot be printed.

❍ Do not open the memory card cover, remove the memory card, detach
the USB cable or turn off the camcorder while data is being transferred
to the printer (when the camcorder’s card access indicator is flashing).
Doing so may cause memory card data to become corrupted.

❍ If you are using a network printer and the printer name (including the
network path) exceeds 31 characters, it may not be possible to print
from PhotoRecord. If this happens, open [Control Panel] on the [Start]
menu. Click the [Printers] icon and change the name of the your
printer, limiting its length to within 31 characters.

1. Click [Print] in the Main Window.

2. Click [Layout Print].
When you wish to print an index, select [Contact Sheet Print].

Printing Still Images (PhotoRecord)
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Printing Still Images (PhotoRecord)

3. Select the still image you wish to print and click [Select
Captions for Printing].
You can select multiple images by continuously clicking on the images. Click
on the image again to deselect.

4. Select the image information you wish to include in the print
and click [Open Layout Print].
• PhotoRecord starts.
• Place a check mark beside the items you wish include in the print.
• If you wish to add a comment, select a still image and enter a comment in

the [Properties] window by clicking  (Properties).
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5. Click [Select Printer & Album Type] and select a printer and

album type.

6. Click [Select Paper] and select the media type, paper size and
page orientation.
• If you click [Decorate Album], you can change the theme (a consistent

design for background, photo frames and text frames), or set the design
elements individually. When you set the design elements individually,
make sure to select the target page.

• If you click [Add Titles & Captions], you can add titles and text, and
change font, font size, justification and color. Make sure to select the
target page when performing these changes.

Select the printer.

Select the album type.

Set the paper type and orientation.
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Printing Still Images (PhotoRecord)

7. Click [Print], confirm the number of copies and other print
settings, and click [Print].
Printing starts.

PhotoRecord automatically performs image correction for images shot
with Exif 2.2 compatible camcorders and even other images, yielding
high-quality prints.

Selecting the Print Mode and Number of Copies (DPOF Print Settings)

You can select the image and the number of prints (  print setting) for
automatic printing on a DPOF*-compliant printer. You can set the DPOF print
settings also on the camcorder.
* Digital Print Order Format

When you are using a SD memory card, make sure the protect switch is
set to allow recording.

1. Click [Set] in the Camera Window and select [Slide/DPOF] in
the displayed menu.
The Edit Slide/DPOF window appears.
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copies.
• [Standard Print]: Prints selected images in the specified number of copies.

Use the arrows next to the boxes below the image to select the number
of copies.

• [Index Print] and the option [Titles] of the [Edit] menu (printing of date and
file number) are not supported by the camcorder.

3. Click [Save to Camera].
The DPOF print settings will be saved to the memory card.

The Edit Slide/DPOF window allows print settings on up to 998 still
images. With some camcorders, DPOF print settings are limited to a
maximum of 200 still images. In that case, all DPOF print settings on the
201st still image and onward will be erased.
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You can merge a series of overlapping still images into a single, seamless
panorama. PhotoStitch automatically arranges still images recorded with the
camcorder’s Stitch Assist mode in their correct order and orientation, making it
easy to merge them. Please refer to the Camcorder Instruction Manual to learn
how to record in Stitch Assist mode.
The following instruction explains how to merge still images recorded in Stitch
Assist mode with the camcorder.

Still images recorded in Stitch Assist mode with Wide-converter or Tele-
converter attached cannot be merged correctly.

1. Click the arrow in the Camera Window.

2. In the confirmation window, click [OK].
PhotoStitch starts.

Merging Panoramic Images (PhotoStitch)

Still images recorded with the 
camcorder’s Stitch Assist mode



W
in

d
o

w
s

53

E
3. Arrange the order of the images and click [2.Merge].

Operational instructions are displayed in the upper section of the window.

4. Click [Start].
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❍ You can record the surroundings in 360 degrees, and stitch them
together later to form a 360-degrees cylinder. (In [1. Selection and
Arrangement], select [Arrange] and [360 degrees].) By saving this
stitched image in QuickTime VR format, you can then get a virtual
view of the surroundings by manipulating the mouse. For this, you
need to have QuickTime installed on your computer.  If it is not already
installed, install it from the DIGITAL VIDEO SOLUTION DISK For
Windows.  Place the disk in the CD-ROM drive and click [QuickTime
Installation] in the installer panel.

❍ Please refer to the PhotoStich Help menu for more details.

Merging Panoramic Images (PhotoStitch)

5. Select [3. Save] and then click [Save].
• Select the destination folder, input the file name and click [Save].
• In the View the Saved Image? window, click [Yes]. The Viewer window

opens and displays the merged image.
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You can change the size, resolution or file format of selected still images and
save them as new files, or export still images for use as screen saver or
wallpaper. You can also export selected movie and still image information to text
file, or copy and rename movies and still images.

1. Click [View & Modify] in the Main Window.

2. Click [Export Images].

3. Select the images and click [Select Export Type].
You can select multiple images or a folder to include all images in that
folder. (Select only one image if you wish to set it as wallpaper.)

Exporting Images
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4. Select the export type and click [Specify Export Settings].
• [Edit Images and Resave]: Converts still images to another file format,

resizes and saves them as new files. You can select the file format from
JPEG, TIFF, and BMP. You can also specify a prefix to be added to the
exported still images.

• [Export Image Shooting Properties]: Exports selected image information to
a text file.

• [Export Images as a Screen Saver]: Saves still images as a Screen Saver.
• [Export an Image as Wallpaper]: Saves still images as Windows wallpaper.
• [Copy Images and Rename]: Copies and names the selected images. You

can also specify a prefix to be added to the exported images.

Exporting Images
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5. Specify the export settings and click [Finish].

• The options for the export settings vary according to the export type.
Follow the instructions displayed in the window.

• In each case, specify the destination folder and file name for the images
to be exported.

Image information will be saved along with the images when you select
[Edit Images and Resave] and save images in JPEG format, or when you
select [Copy Images and Rename].

Destination Folder
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Adding Still Images from Your Computer to the Memory Card
You can add still images (JPEG) from the computer to a memory card. You can
also add sample images for card mix from the DIGITAL VIDEO SOLUTION DISK For
Windows.

Adding Still Images to the Memory Card

1. Click [Camera & Memory Card] in the Main Window.

2. Click [Upload Images].
If you have already selected an image, move on to the step 4.
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3. Select the still images you wish to add and click [Open

Camera Window].
You can select multiple still images by continuously clicking on the still
images. Click on the still image again to deselect.

4. In the Add Image window, select the image size and click
[Add].
• The selected still images will be recorded to the memory card.
• When recording is complete, the still images will appear in the Camera

Window.
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Adding Still Images from Your Computer to the Memory Card

Adding Sample Images to the Memory Card
You can add sample images for card mix and card animation to the memory
card. 4 images for CARD CHROMA, 2 images for CARD LUMINANCE, 2 images
for CAMERA CHROMA and 4 images for CARD ANIMATION are provided on the
DIGITAL VIDEO SOLUTION DISK For Windows.

1. Insert the DIGITAL VIDEO SOLUTION DISK For Windows to the
computer’s CD-ROM drive.
If the installer panel appears, click [Exit] to close it.

2. Click [Camera & Memory Card].

3. Click [Upload Images].
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4. In the Folders Area of the Main Window, select the CD-ROM

icon followed by [DVC CARD IMAGE].
Sample images or folders for CARD CHROMA, CARD LUMINANCE,
CAMERA CHROMA or CARD ANIMATION appear in the Browser Area.

5. Select the sample images you wish to add and click [Open
Camera Window].
You can select multiple images by continuously clicking on the images. Click
on the image again to deselect.
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6. In the Add Image window, click [Add].
• The selected images will be recorded to the memory card.
• When recording is complete, the sample images will appear in the

Camera Window.

Adding Still Images from Your Computer to the Memory Card
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Saving Images on CD-R/RW Disks (Windows XP Only)
You can copy and save images to CD-R and CD-RW disks. The shooting
information is copied along with the images.

This function can only be used on a computer that came with a CD-R/RW
drive as standard equipment.

1. Place a CD-R/RW disk in the computer‘s CD-ROM drive.

2. If the following window appears, click [Cancel].

3. Click [View & Modify] in the Main Window.
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4. Click [Backup to CD].

5. Select the folders or images you wish to save and click
[Specify Backup Settings].

6. Select the CD-R/RW drive, enter a title and click [Start
Backup].

The disk will be ejected from the drive when copying is complete.

You can add images to a CD-R/RW disk that already contains images.

Saving Images on CD-R/RW Disks (Windows XP Only)
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The start-up image, start-up sound, shutter sound, operation sound and self-
timer sound are called the My Camera Settings.
ZoomBrowser EX already contains several My Camera Settings which can be
selected in theme sets or individually. The “Animal” theme, for example features
and animal in the start-up image and animal calls in each of the sound files. The
files all begin with the same word (e.g. “Animal”, “Baseball”).
You can use the pre-recorded My Camera Settings, add still images to the My
Camera Window (  68) or create original sounds files (  69).

Observe following precautions while the My Camera Settings are saved to
the camcorder.
• Do not open the memory card cover or remove the memory card.
• Do not detach the USB cable.
• Do not turn off the camcorder or computer.
• Do not change the position of the POWER switch or TAPE/CARD switch

Customizing Your Camcorder with the My Camera Settings

Saving the My Camera Settings to the Camcorder

1. In the Main Window, click [Camera & Memory Card] followed
by [My Camera Settings].
The My Camera Window (  67) appears.

2. In the My Camera window, select the theme set you wish to
save to the camcorder in the [My Computer] list.
• To change the settings individually, select the [Set individually] tab and

select the setting type in the [Data Type] list.
• A window appears when you select a theme set and plays back the start-

up, shutter, operation and self-timer sound.
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Customizing Your Camcorder with the My Camera Settings

3. Select the setting you wish to replace in the [Camera] list and
click [Save to Camera].

4. On the confirmation window, click [OK].
• The selected setting replaces the old setting and appears in the [Camera]

list.
• If you wish to use this setting on the camcorder, change the My Camera

Setting on the camcorder itself. Refer to the Camcorder Instruction
Manual for details.

Alternatively, you can display the My Camera window from the Camera
Window by clicking [Set] and selecting [My Camera] from the displayed
menu.
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My Camera Window

Selects the type of the 
My Camera Settings. Displays the

My Camera 
Settings of
the camcorder.

Saves the setting 
of the camcorder 
to the computer.

For individual
settings.

For setting in
theme sets.

Displays the
My Camera 
Settings saved
on the 
computer.

Adds an image
file to the
[My Computer]
list.

Plays back the
sound setting 
selected in the 
[My Computer] list.

Plays back the 
sound setting 
selected in the
[Camera] list.

Deletes a setting
from the 
[Camera] list.

Saves the setting
from the computer
to the camcorder.

Deletes a setting 
from the [My 
Computer] list.
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Customizing Your Camcorder with the My Camera Settings

Adding Still Images to the My Camera Window

To use still images recorded with your camcorder, you need to download
them to the computer before you can add them to the My Camera
Window.

1. In the My Camera window, click the [Set individually] tab,
select [Startup Image] in the [Data Type] list and click [Add
File].
The file opening window appears.

2. Select the still image file (JPEG) you wish to add and click
[Open].
The selected file appears in the [My Computer] list. You can now save the
newly added file to the camcorder using the procedures described in Saving
the My Camera Settings to the Camcorder (  65).

To delete a setting, select the file and click the [Delete] button below the
[My Computer] list.
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Creating an Original Sound File and Adding it to the My Camera Window

❍ QuickTime is required to play back the sound. If QuickTime is not
already installed on your computer, install the QuickTime from the
DIGITAL VIDEO SOLUTION DISK for Windows. Place the disk in the CD-
ROM drive and click [QuickTime Installation] in the installer panel.

❍ You need to connect a microphone to the computer.

1. In the Main Window, select [Create a My Camera Sound] from
the [Camera] menu.
The My Camera Sound Maker window appears.

2. Click the tab of the sound type you wish to create and click
[Record].

3. To begin recording, click the [Start] button.
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Customizing Your Camcorder with the My Camera Settings

4. Click the [Stop] button to stop recording, and click [Close].
Recording stops automatically after 30 seconds.

5. Edit the sound data so that it confirms to the time limits.
• Select the sound type by clicking the [Sound Format] button.
• Adjust the length of the recording to conform with the time limits by

moving the blue and red switches and clicking the [Cut] button.

• The following chart shows standard time lengths for My Camera sounds.

Sound Type
Lengths in Seconds

11.025 kHz 8.000 kHz

Start-up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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6. Click the [Save] tab, check if the sound file was created and

click [Save].

7. Input a file name and click [OK].
• The created sound file appears in the [My Computer] list.
• You can now save the newly created sound file to the camcorder using

the procedures described in Saving the My Camera Settings to the
Camcorder (  65).

8. Click  to close the My Camera Sound Maker window.



72

Setting ZoomBrowser EX to Start Automatically

You can set ZoomBrowser EX to start automatically when you connect the
camcorder to the computer.

1. Insert a memory card containing images into the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  19).
When a window appears allowing you to select an application program to
start, click [Cancel].

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver/WIA
Driver Uninstallation (  82).

7. Make sure that [Canon Camera] is selected and click
[Properties].

8. Click the [Events] tab.

Windows 98/Windows 2000
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9. Remove the check mark from all programs except

ZoomBrowser EX and click [OK].
The next time the camcorder is connected, ZoomBrowser EX starts and the
Camera Window opens automatically.

1. Insert a memory card containing images into the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  19).
When the Scanners and Cameras Wizard opens, click [Cancel].

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver/WIA
Driver Uninstallation (  82).

Windows Me
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Setting ZoomBrowser EX to Start Automatically

7. Double click the [Canon Camera] icon.

8. Click the [Events] tab.

9. In the [Actions] section, select [Start this program], set it to
[Canon ZoomBrowser EX] and click [OK].

❍ When you have restarted your computer, a window appears allowing
you to select an application program to start.

❍ Select [Canon ZoomBrowser EX], place a check mark beside “Always
use this program for this action” and click [OK].
• ZoomBrowser EX starts and the Camera Window opens

automatically.
• The next time the camcorder is connected, ZoomBrowser EX starts

and the Camera Window opens automatically.
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Windows XP

1. Insert a memory card containing images into the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  19).
A window appears allowing you to select an application program to start.

5. Select [Canon ZoomBrowser EX], place a check mark next to
“Always use this program for this action” and click [OK].
The next time the camcorder is connected, ZoomBrowser EX starts and the
Camera Window opens automatically.
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Auto-Downloading Settings
You can set the action that is carried out when ZoomBrowser EX is started.
When you set ZoomBrowser EX to automatically download images from the
camcorder when ZoomBrowser EX is started, specify the download settings.

1. In the Main Window, select [Auto-download setting] from
the [Camera] menu.

2. Enable or disable the auto-download setting and click [Select
Image Type].
• When you selected [Images are not automatically downloaded....], click

[Setup Completed]. The setup process is complete.
• When you selected [Images are automatically downloaded....], click [Select

Image Type] and move on to the steps 3 to 5.
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3. Select the image type to be downloaded and click [Save In].

4. Select the destination folder in which you wish to save the
image and click [Set Action].

This option is not supported by the camcorder.



78

Allows you to perform one of the following processes in succession.
  •Layout Print
  •Contact Sheet Print
  •View as slideshow
  •Send by e-mail

Allows you to display the folder in which 
the images have been saved after downloading them.

Auto-Downloading Settings

5 Set the action to be carried out after images are downloaded
and click [Setup Completed].
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❍ Uninstall also the Camera Window when you have uninstalled
ZoomBrowser EX.
Click the Windows [Start] menu and select [All Programs], [Canon
Utilities], [Camera Window] and [Camera Window Uninstall].

❍ PhotoRecord and PhotoStitch can be removed with the same
procedure.

❍ RemoteCapture Task and RAW Image Task are used with Canon digital
cameras. The camcorder does not support these programs.

Uninstall the software when you wish to delete it from your computer or when
reinstallation is required to fix corrupted files.

Users of Windows 2000 and Windows XP must first log in as an
Administrator to uninstall the driver and other programs.

Uninstalling ZoomBrowser EX

1. Click the Windows [Start] menu and select [All Programs],
[Canon Utilities], [ZoomBrowser EX] and [ZoomBrowser EX
Uninstall].
The uninstall utility starts and removes ZoomBrowser EX.

Uninstalling the Software
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Uninstalling the TWAIN Driver/WIA Driver
Users of Windows XP do not need to uninstall the driver.

1. Connect the camcorder to the computer using the supplied
USB cable (  19).
A window for selecting an application program or the Scanners and
Cameras Wizard appears, or ZoomBrowser EX starts.

2. If the window for selecting an application program or the
Scanners and Cameras Wizard appeared, click [Cancel]. If
ZoomBrowser EX started, close it.

3. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

4. Double-click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver/WIA
Driver Uninstallation (  82).

5. Windows 98/Windows 2000:
1. Delete [Canon Camera] from the [Scanners and Cameras Properties] list.
2. Click [OK] to close the window.
3. Click the Windows [Start] menu and select [Programs], [Canon Utilities],

[DV TWAIN Driver x.x] and [TWAIN Driver Uninstall].
 A version number appears in place of “x.x”.

Windows Me:
1. Delete the camcorder icon from the [Scanners and Cameras] folder.
2. Click [OK] to close the window.
3. Click the Windows [Start] menu and select [Programs], [Canon Utilities],

[DV WIA Driver x.x] and [WIA Driver Uninstall].
 A version number appears in place of “x.x”.

6. When the Confirm Uninstall window appears, click [OK].
The uninstall process starts.

7. When the Maintenance Complete window appears, click
[Finish].

Uninstalling the Software
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Troubleshooting

Connection

? Camcorder is not recognized when connected to the
computer.

➜ Computer does not support the USB interface.
The USB interface is not supported for computer not in compliance with the
following requirements. Acquire the necessary system to use the USB
interface.
Requirements: Built-in USB port on a system pre-installed with Windows XP,
Windows 2000, Windows Me, Windows 98 (First or Second Edition).

➜ There is no memory card in the camcorder.
Insert a memory card into the camcorder.

➜ The camcorder is not set to the correct mode.
Turn the POWER switch to PLAY (VCR) and move the TAPE/CARD switch to
CARD.

➜ Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer (  19) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

➜ If you are experiencing operational problems, detach the USB cable
from the camcorder and computer and terminate the connection.
Restart the computer and then reconnect the camcorder.

➜ TWAIN Driver or WIA Driver is not installed properly.
First uninstall the TWAIN/WIA Driver, then reinstall the driver from the
DIGITAL VIDEO SOLUTION DISK For Windows (remove the check marks from
the other programs when prompted to select the programs to be installed).
For uninstalling, refer to Uninstalling the TWAIN Driver/WIA Driver (  80).
For installing, refer to Installing the TWAIN Driver/WIA Driver (  17).

ZoomBrowser EX Operation

? Cannot download images

➜ The camcorder it not set to the correct mode.
Turn the POWER switch to PLAY (VCR) and move the TAPE/CARD switch to
CARD.
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Troubleshooting

? Image files or folders do not appear in ZoomBrowser EX.

➜ Images of folders shown in ZoomBrowser EX and the actual file
contents may be different when an image file has been moved or
copied using Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].

Driver Installation

? Cannot install the TWAIN Driver/WIA Driver correctly.

➜ Does the system have a built-in USB port and did it come with
Windows 98 (First or Second Edition), Windows Me or Windows 2000
preinstalled?

➜ Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer (  19) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

➜ Are you using the power adapter to power the camcorder?

➜ If the problem is not mentioned above, the TWAIN Driver/WIA Driver
may not have been recognized by Windows.
Uninstall (  80) and reinstall (  17) the driver.

TWAIN Driver/WIA Driver Uninstallation
If you had problems uninstalling the driver, use the following procedures to
remove it.

The [Inf] folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you delete
the wrong file, you may be unable to restart Windows.

Use the procedures below for the following circumstances too.
❍ If you do not find [Scanners and Cameras] in the [Control Panel] or

[Printers and Other Hardware].
❍ If [Canon Camera] or your camcorder model name does not appear in

the [Scanners and Cameras Properties] or [Scanners and Cameras].
❍ If you connected the camcorder to the computer via the USB cable

before installing the Digital Video Software.
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1. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

2. Double-click the [System] icon.
The [System Properties] dialog appears.

3. Click the [Device Manager] tab.

4. If [Canon Camera] appears under the [Other Devices] and/
[Imaging Devices] categories, use the following procedures to
delete it.
1. Select [Canon Camera] and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

5. Double-click the [My Computer] icon on the desktop followed
by the [C:] drive and the [Windows] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Windows] Folder
1. Windows 98: Click the [View] menu and select [Folder Options].

Windows Me: Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. Windows 98: Set the [Hidden files] section to [Show all files].

Windows Me: Set the [Hidden files and folders] section to [Show
hidden files and folders].

4. Click [OK].
This makes the [Inf] folder and files in the [Inf] folder visible.

6. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

7. In the [Inf] folder, double-click [Other] folder to open it.

8. Find and delete the [Canon.Inc CAP015NA.inf] or [Canon.Inc
CAP015NB.inf] file.
If the above file is not contained in the [Other] folder, you do not need to
delete anything.

Windows 98/Windows Me
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Troubleshooting

Windows 2000

Leave the camcorder connected to the computer.

1. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

2. Double-click the [System] icon.

3. Click the [Hardware] tab.

4. Click the [Device Manager] button.

5. If [Canon Camera] or your camcorder model name appears
under the [Other Devices] and/or [Imaging Devices]
categories, use the following procedures to delete it.
1. Select [Canon Camera] or the name of the camcorder model, right-click

the mouse button and select [Delete].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

Remove all copies of [Canon Camera] or your camcorder model name
that appear in the [Other Devices] or [Imaging Devices] categories, or
that appear more than once in one category.

6. Double-click the [My Computer] icon on the desktop,
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder
Use the following procedures to show all files and folders.
1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Advanced setting] section, set the [Hidden files and folders]

category to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check
mark.

4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.
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7. Look for the file starting with [Oem*].

• A number such as ”0” or “1” will appear in place of the asterisk (*)
above. You will also find another file called [Oem*.pnf], which will have
the same number as the [Oem*] file. The two constitute one set.

• There may be many file sets starting with “Oem”.
• If you double-click the [Oem*] file, the Windows Notepad program will

start and show the file contents. Click each [Oem*] file until you find one
that contains “*** Canon Camera Driver Setup File***” in its first line.
When you find the correct file, note down its name and close the
Notepad window.

8. Delete the [Oem*] file set.
Delete all [Oem*] and [Oem*.pnf] files, taking great care to delete the
correct files.

If You Were Using ZoomBrowser EX Version 2 or 3
 (This manual explains version 4)

? Titles and comments added using a prior version than
ZoomBrowser EX version 4 do not appear in ZoomBrowser
EX 4 or higher.

➜ Titles and comments added using a prior version of ZoomBrowser EX
will not be displayed. Use the following procedure to display them.
1. In Windows Explorer, open the [Program] folder under the folder in

which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program).

2. Double-click [dbcobverter.exe].
3. Select the database you were using until now (C:\Program Files\Canon\

ZoomBrowser EX\Program) and click the [Start] button.
Please note that with ZoomBrowser EX 4 or higher, both titles and
comments appear in the comment list.

? Cannot find the image folders saved with a prior version
than ZoomBrowser EX 4.

➜ Image folders saved under the [Program Files] folder (such as [Image
Library One]) cannot be displayed in the Main Window’s Folder Area
of ZoomBrowser EX 4 or higher. Use the following procedure to
display them.
1. In Windows Explorer, open the [Program Files] folder under the folder in

which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program\Image Library One).

2. Select the image folder you wish to display and copy the folder to a
different destination.
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OS: Mac OS 9.0-9.2, Mac OS X (version 10.1/10.2)
Computer Model: Computers that come with above OS preinstalled and

have built-in USB ports.
CPU: PowerPC
RAM: Mac OS 9.0-9.2: 64 MB or more of application memory

Mac OS X (version 10.1/10.2): 128 MB or more
Interface: USB
Free Hard Disk Space: Canon Utilities

– ImageBrowser 120 MB or more
– PhotoStitch 30 MB or more

Display: 800 × 600 pixels/32,000 colors or better, 1,024 × 768
pixels/32,000 colors or better is recommended

❍ Proper operation is not guaranteed on a user-built PC.
❍ Proper operation is not guaranteed on any particular system, even if it

meets the requirements outlined above.
❍ ImageBrowser and PhotoStitch do not operate on disks formatted with

the Unix File System (UFS).
❍ A CD-ROM drive is required to install the software.
❍ Connect the USB cable directly to one of the computer’s main USB

ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

❍ The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

❍ Do not connect two or more camcorders to the same computer via the
USB interface. The connections may not operate correctly.

❍ Not all operations performed with a connection to a USB 2.0
compatible board can be guaranteed.

Macintosh  System Requirements
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What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained on
the DIGITAL VIDEO SOLUTION DISK For Macintosh.

■ ImageBrowser (  92)
• Downloading images recorded onto a memory card to your computer.
• Categorizing and organizing large volumes of images.
• Creating mail attachments from images.
• Adding a title and a comment, and printing still images.
• Printing indexes.

■ PhotoStitch (  119)
Merging panoramic images.
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Installing the Software
Before you connect the camcorder to the computer with the USB cable
for the first time, you must install the Digital Video Software.

Mac OS X (version 10.1/10.2) Users:
Your digital video camcorder is equipped with the standard Picture
Transfer Protocol (PTP). This protocol enables you to download images by
simply connecting the camera to a computer with the USB cable (using
software such as iPhoto or Image Capture preinstalled on Mac OS X).
However, please note that there are several limitations to downloading
images with this method. To avoid these problems, install ImageBrowser
to download images.
❍ It may take a few minutes, after connecting the camcorder, until you

can download images.
❍ Only AVI* movie files can be downloaded. Thumbnails cannot be

downloaded.
* Two files are created in the camcorder (for example: [MVI_0001.AVI]

and [MVI_0001.THM]). [MVI_0001.THM] files cannot be downloaded
but movies can still be played back on the computer.

❍ Mac OS X version 10.2
• You may not be able to download images with iPhoto if the memory

card contains an enormous volume of images (approx. 900 or more).
• The Exif* version may change to 2.1 and image information may be

modified when downloading images with Image Capture. To
download images without any information changes, use the
following procedures:
1. Connect the camcorder to the computer and prepare it to

transfer data.
2. Start Image Capture.
3. In the screen that appears, click [Options].
4. Remove the checkmark from [Embed Colorsync profile] in the

[Download Options] tab and click [OK].
* Images shot with camcorders complying with Exif Print

incorporate shooting settings information, such as the shooting
conditions and program AE mode, along with the image data.

1. Close any programs that are running.

2. Set the DIGITAL VIDEO SOLUTION DISK For Macintosh in the
computer’s CD-ROM drive.
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3. Mac OS 9.0-9.2: Double click the CD-ROM icon, followed by

the [Mac OS 9] and [Canon Digital Video Installer] icons.
Mac OS X (version 10.1/10.2): Double click the CD-ROM icon,
followed by the [Mac OS X] and [Canon Digital Video
Installer] icons.
The installer panel appears.

4. Select your language.

5. Click [Digital Video Software Installation].

6. Select the programs you wish to install and click [Install].
Confirm that there is a check mark beside the name of the program you
wish to install.

7. Select your country/region and click [Next].

8. Read the license agreement and click [Agree].

Installer Panel
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9. Select the installation destination and click [Choose].
Installation starts.

10.When the message “Installation has finished.” appears, click
[OK].

11.After the installation is complete, restart the computer as
prompted.

Installing the Software
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Connecting the Camcorder to a Computer
❍ Make sure the camcorder is being powered using the power adapter

before connecting it to a computer.
❍ Be sure to install the Digital Video Software before you connect the

camcorder to the computer.
❍ Connect the USB cable directly to one of the computer’s main USB

ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

❍ The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

❍ Do not connect two or more camcorders to the same computer via the
USB interface. The connections may not operate correctly.

❍ Never allow the computer to go into standby (sleep) mode while
a camcorder is connected via the USB interface. If it does happen,
never disconnect the USB cable. Try to awaken the computer with
the camcorder in the connected state. Some computers will not
awaken properly if you disconnect the camcorder while they are
in standby mode. Please refer to your computer manual for
instructions regarding its standby mode.

1. Insert a memory card containing images into the camcorder.

2. Connect the power adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
• Refer to your computer manual for the location of the computer’s USB ports.
• See your camcorder instruction manual for connecting instructions.

USB Cable

Camcorder End Computer End

USB Terminal
on the Camcorder

USB Port on 
the Computer
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Downloading Images (ImageBrowser)

Below explains the procedure for connecting a camcorder to a computer using
the USB cable.
For connecting a PC card reader/writer, see Using a PC Card Reader/Writer
(   98).

❍ Observe following precautions when the camcorder’s card access
indicator is flashing (the camcorder is reading or writing from or to the
memory card). Failure to do so may cause memory card data to
become corrupted.

– Do not open the memory card cover, remove the memory card or
detach the USB cable.

– Do not turn off the camcorder or the computer.
– Do not change the position of the POWER switch or the TAPE/

CARD switch.
❍ Format the memory card with the camcorder or from the Camera

Settings Window (  100).
❍ Images recorded onto the memory card or downloaded to the hard

disk are important original data files. Create a copy of the file first
before working on it on your computer.

Starting ImageBrowser

1. Insert a memory card containing images into the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  91).
• ImageBrowser starts and the ImageBrowser Automation Wizard dialog

appears. In the ImageBrowser Automation Wizard dialog, you can select
the action that is carried out after ImageBrowser starts.

• A dialog with the previously selected automated settings will appear the
next time you start ImageBrowser.
1. To use these settings unchanged, click the [Start] button.
2. To do nothing, click [Cancel].
3. To change the settings, click [Settings Change], select the action and

click [OK].

Mac OS 9.0-9.2
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How to Set ImageBrowser to Not Start Automatically

1. Click the Apple menu  and select [Control Panels] and
[Canon ImageBrowser Auto Launch].
The Settings for USB Connection dialog will display.

2. Click [The application program below will start] to remove
the check mark.

3. Click the close box  at the upper left to close the dialog.
ImageBrowser will cease to start automatically thereafter.

Click here to close the dialog.

5. Select [Display Images] and click [OK].
The Communications Settings window appears. This window only appears
the first time the camcorder is connected.

6. Confirm that [USB port] and [Canon Camera] are selected and
click [Set].
The Camera Window opens, displaying the camcorder images as
thumbnails (small images).
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Downloading Images (ImageBrowser)

Do not connect the camcorder while the Classic environment is started.
Likewise, do not start the Classic environment while the camcorder is
connected.

1. Insert a memory card containing images into the camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  91).

5. Double-click the [Canon ImageBrowser] icon on the desktop.
If the Canon ImageBrowser icon does not appear on the desktop, double-
click the [Canon Utilities] folder on the drive on which the program was
installed, followed by the [ImageBrowser] folder and [ImageBrowser] icon.

6. Click [Canon Camera] in the Explorer View section.
The Communications Settings window appears. This window only appears
the first time the camcorder is connected.

Explorer View Section

Mac OS X (version 10.1/10.2)
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Explorer View Section

Downloading Images to the Computer

1. Mac OS 9.0-9.2: Select [Macintosh HD] in the explorer view
section.

Mac OS X (version 10.1/10.2): Select the [  (user name)]
subfolder of the [Users] folder in [Macintosh HD].

7. Confirm that [USB port] and [Canon Camera] are selected and
click [Set].
The Camera Window opens, displaying the camcorder images as
thumbnails (small images).
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Downloading Images (ImageBrowser)

2. Create a new folder for saving images from the memory card
in the camcorder.
Click the [File] menu and select [New Folder]. A folder with the name
“Untitled” will be created. Click it to change the folder name as you wish.
In this example, we will input “ZOO.”

3. In the Explorer View Section, click the newly created folder.

4. Select images in the Camera window and click [DOWNLOAD].
• You can select multiple images by holding down [Shift] or [Option] +

[Shift] while clicking.
• A blue frame appears around the selected image.
• Downloaded images are saved to the computer and appear in the

Browser area.

Thumbnail

Explorer View Section



M
ac

in
to

sh

97

E

Explorer View
Section

Browser area

To disconnect the camcorder, click the close box (Mac OS 9.0-9.2) or the red
close box (Mac OS X (version 10.1/10.2)) at the upper left of the Camera
Window. The Camera Window will close.

❍ Double-clicking an image on the camera window imports it to the
computer.

❍ You can also download images to the computer by dragging them
from the Camera window and dropping them on the Browser area or
the Explorer View Section.
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Using a PC Card Reader/Writer
The basic operations of ImageBrowser are the same as when you connect the
camcorder to the computer. Follow the procedure below to open the Camera
Window.
For instruction on how to connect the PC Card Reader/Writer, please refer to the
PC Card Reader Manual.

1. Insert a memory card into the reader.
Mac OS X (version 10.1/10.2): If a dialog appears, click the red close box.

2. Double-click the [Canon ImageBrowser] icon on the desktop.
• ImageBrowser starts.
• If the icon does not appear on the desktop, double-click the folder in

which you installed the program, followed by the [Canon Utilities] and
[ImageBrowser] folders and the [ImageBrowser] file.

3. Double-click the [CANON_DV] and [DCIM] folders in the
Explorer View Section.
The Camera Window opens, displaying the memory card images as
thumbnails (small images).

Explorer View Section

Downloading Images (ImageBrowser)
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Using Other ImageBrowser Functions

Camera Window
The Camera Window opens when a connection to a camcorder is initiated.
Images will be displayed as thumbnails (small images). Movies are displayed with
the first scene as a still image, indicated with a movie icon. Buttons are activated
when an image is selected.

[SETUP OPTIONS]: Adjusts the connection settings and camcorder
settings. Menu options: Camera Settings,
Communication Settings and My Camera.

[CONNECT CAMERA]: Reconnects the camcorder to the computer.
[SELECT]: Selects images. Menu options: Select All and

Deselect All.
[DELETE]: Deletes selected images.
[DOWNLOAD]: Downloads selected image to the computer.
[PRINT]: Prints selected still images. Menu options: Layout

printing and Index printing.
[ROTATE]: Rotates still images. Menu options: 90 degrees

right, 90 degrees left and 180 degrees.
[UPLOAD]: Adds selected still images to the memory card.
[IMAGE INFO]: Displays image information (such as shooting date/

time and image size).
[SLIDE/DPOF]: The [SLIDE] function cannot be used. [DPOF] allows

you to select the print order settings.

Thumbnails
The image is displayed 
in reduced size.

The model name of your 
camcorder appears in place of the 
asterisks (*****).

Movie icon
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Using Other ImageBrowser Functions

Camera Settings Window
You can adjust the date, time and owner settings in the Camera Settings
window using the computer when the camcorder is connected. You can also
check the remaining memory card capacity.

1. In the Camera Window, click the [SETUP OPTIONS] button and select
[Camera Settings] from the displayed menu.

2. Check or change the settings.
Click [OK] to close the window.

Input a camcorder owner name here 
(up to 31 characters).

Set the date and time here.

Check this box to synchronize the camcorder 
to the computer’s date and time settings.

Check the power status here.

Click this to format the memory card 
in the camcorder. 

Check the remaining memory card 
capacity here.
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Browser Window
This section describes the various parts of the Browser Window display.

[CANON CAMERA]: Displays the Camera Window.
[SELECT]: Selects all images in a folder. Menu options: Select All

and Deselect All.
[SEND TO TRASH]: Deletes selected images.
[REDUCE]: Reduces the size of the thumbnails in the Browser Area.
[ENLARGE]: Enlarges the size of the thumbnails in the Browser Area.
[DISPLAY IMAGE]: Displays a still image in the Image Viewer window, or

opens a window for playing back a movie.
[PRINT]: Prints selected still images. Menu options: Layout

printing and Index printing.

Image Name
This is where 
the file name 
of each 
individual
image is 
displayed.

Explorer View Section
Displays the disks and folders 
that you can use on your 
computer.
If you click the disclosure 
triangle on the left edge of the 
display, you can switch between 
collapsing and expanding the 
contents of that folder.

You can drag this line to 
change the position of the 
boundary between the 
Explorer View Section and 
the Browser Area.

You can drag this part 
of the frame to change 
the size of the Browser 
Window.

Control Panel
This area contains 
buttons that allow you 
to perform a variety of 
functions.

Browser Area
Displays the images contained in the 
selected folder.

You can select to display thumbnails 
or preview images.
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Using Other ImageBrowser Functions

Image Viewer Window
The Image Viewer window appears when you double-click a still image, or when
you select a still image and click [DISPLAY IMAGE].

CROP
You can extract a part of the still image.
1. Click on the still image and drag to form a 

rectangular frame. 
You can move or change the size of the frame.

2. Click this button to extract the area within the 
frame.
The extracted part of the still image appears.

ADJUST COLOR
Click here to display the Adjust 
Color window to adjust hue, 
saturation and lightness of the
still image by dragging the 
respective slide.

Enlarge or reduce
the still image

Current zoom ratio
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Displaying the Image Information
You can check the image information such as shooting date/time or file size.

1. Select the image of which you wish to display the
information.

2. From the [File] menu, select [Get Info].
• The File Information window appears.
• If you wish to add a comment, input it in the [Comment] area.
• Click [OK] to close the window.

❍ It depends on your camcorder model which image information will be
displayed.

❍ When you modify and save an image using another program, shooting
information or comments may be lost.
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[View] Menu
You can select the display settings of the Browser Area by selecting [View
Settings] from the [View] menu.

If you select [View Mode] followed by [Preview] from the [View] menu, you can
display a preview of an image in the Browser Area. To stop displaying the
preview image, select [View Mode] followed by [List] in the [View] menu.

Allows you to 
enlarge and 
reduce the size 
of the 
thumbnails.

Allows you to 
enlarge or 
reduce the 
size of the 
thumbnails.

Allows you to select 
the information 
displayed under the 
thumbnails.

Allows you to select 
the operating panel 
displayed below the 
Browser Area.

Using Other ImageBrowser Functions
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This program displays images in the order of the creation date.

1. In the [View] menu, select [View Mode] followed by
[TimeTunnel].
The image information will be displayed when you point at an image.

Displaying Images in TimeTunnel

Double-click a thumbnail 
to display it in another window.

The date/time at which the images were 
shot appears on the red line. You can change 
this date/time by double-clicking it on the 
display. A window similar to the one below 
appears. Specify the new date/time.

Click to display the control panel.
[Display Tool Panel]: 
Select to display or hide the tool 
panel.

[Auto Cruise]: 
Enables or disables [Auto Cruise]. 
When [Auto Cruise] is active, the time 
movement continues even after you 
have moved and released the bar.

[Switch to Browser View]: 
Exit TimeTunnel, and returns to the 
previous screen.

Tool Panel

Allows you to 
specify the date 
for the images 
displayed.

Makes the 
TimeTunnel look 
curved.

Makes the 
TimeTunnel rings 
octagonal.

Changes the number 
of TimeTunnel rings.

Move the slider up 
or down to move 
backward or 
forward in time.
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Playing Back Movies From a Memory Card

In the Camera Window and Browser Area, movies are displayed with the first
scene as a still image with a movie icon (  ). When you double-click the
thumbnail in the Browser Area, QuickTime Player starts and plays back the
movie.

1. In the Browser Area, double-click a thumbnail with a 
(movie) icon.
QuickTime Player starts.

2. Click the e (play) button in QuickTime Player.
The movie will be played back.
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Running a Slide Show

1. From the [View] menu, select [Slide Show Options].

2. Select the slide show settings and click [OK].
• [Auto Play]: Moves to the next still image automatically. Select the interval

by sliding the control under [Play Interval] (from 1 to 30 seconds).
• [Control with Mouse or Keypad]: Advances the slide show manually with

the mouse or keyboard.
• [Repeat Continuously]: Runs the slide show in a loop.
• [Hide buttons]: Hides the buttons during the slide show.
• [Transition Effect]: Select the transition effect to be used when moving

from one slide to another. When you select an effect, you can check the
effect in the preview window.

3. Select the images and select [Slide Show] from the [View]
menu.
Click  on the lower right of the screen to end the slide show.
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To add sound to still images, use the MAC OS recording function. Depending on
the computer, you may need to connect peripherals such as microphones.
Check if your computer settings allow recording.
The sound cannot be played back on the camcorder.

Adding Sound to a Still Image

1. In the Browser Area, select a still image and select [Record]
from the [Sound] menu.
The recording window appears.

2. Click  and start recording when the [Save] button is
enabled.

3. Click [Save] to stop recording.

•  appears on the still image.
• The sound file will be copied in AIFF format (extension “.AIF”) to the same

folder as the still image.

To remove sound from a still image, select [Send to Trash] from the
[Sound] menu.  disappears and the copied sound file will be deleted.

Adding Sound to a Still Image
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2. In the Browser Area, select the still image with the sound
attachment.
You can record or play back the sound, adjust the volume, or stop or pause
playback.

The sound panel appears.

Playing Back the Sound

In the Browser Area, select the still image with the sound
attachment and select [Play] from the [Sound] menu.
• The sound will be played back.
• You can control playback by selecting [Pause] or [Stop] from the [Sound]

menu.

Using the Sound Panel
You can use the sound panel to record, playback and adjust the volume.

1. From the [View] menu, select [View Settings] and select
[Sound Panel] from the displayed menu.
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You can attach selected images to an E-mail message.

1. Select the images you wish to send in the Browser Area.

2. From the [Internet] menu, select [Create Image for Email].

3. Specify the image size and click [Next].

4. Specify the reduction ratio and image quality and click [Next].
• [Resize (%)]: Select the reduction ratio relative to the original size of the

image.
• [Quality]: Select the image quality. The lower the quality, the rougher the

image becomes, but the size of the file also becomes smaller.
• [Compress]: Use it to check the file size when you actually compress the

image. The file size appears next to “Total Size After Compression”.

Attaching Images to E-mail Messages

Select this if you do not wish 
to reduce the size of the still 
image.

Normally, select this option.
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5. Select whether you wish to start your e-mail software and

click [Finish].
• If you have selected [Start email application after closing], your e-mail

software starts automatically. Open a new e-mail message and attach the
image. With some types of e-mail software, you can attach images to
e-mail messages simply by dragging them from the Browser Area to the
new message window.

• Click [Preview] to check the changed image.
• The image will be saved to the [Email Images] folder in the explorer view

section.

Explorer View Section
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❍ You can set the e-mail software to start automatically in step 5. Note
that some e-mail software may not start automatically.
Mac OS 9.0 ~ 9.2: From the Apple menu, select [Control Panel],
followed by [Internet] and click the [Email] tab. Change the setting in
the displayed window.
Mac OS X (version 10.1/10.2): From the Apple menu, select [System
Preferences], followed by [Internet] and click the [Email] tab. Change
the setting in the displayed window.

❍ The images in the [Email Images] folder are saved in the following
location:
Mac OS 9.0 ~ 9.2: Open the folder you installed ImageBrowser or the
[Document] folder, followed by [ImageBrwoserUserData] and [Mail].
Mac OS X (version 10.1/10.2): Open the [Users] folder, followed by
[User login name], [Library], [Preferences], [ImageBrowserUserData],
and [Mail].

Attaching Images to E-mail Messages
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the USB cable or turn off the camcorder while data is being transferred to
the printer (when the camcorder’s card access indicator is flashing). Doing
so may cause memory card data to become corrupted.

1. Select the still image(s) you wish to print in the Browser
Window.

2. Click [PRINT] and select [Layout printing] from the displayed
menu.
• The Layout Options window and Print window appears.
• If the Layout Options window does not appear, display it by clicking

[LAYOUT OPTIONS] in the Print window.

You can select the layout when printing still images. Movies cannot be printed.

Printing Still Images (ImageBrowser)

Print Window
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Printing Still Images (ImageBrowser)

3. In the Layout Options window, select a layout and click
[Next].
The Custom Layout printing option allows you to freely change the size and
position of the still images for printing. The other options allow you to print
an index or print onto Canon perforated paper. Canon perforated paper
cannot be selected with Mac OS X (version 10.1/10.2).

4. Select a paper size and click [OK].
• The Print window opens, allowing you to change the layout and printing

settings.
• The settings available will vary according to the type of layout selected in

Step 3.
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5. Click [PRINT] in the Print window.

The Print dialog appears.

6. Click [Print].
Printing starts.

The Print Window

Change the Image 
Size
Drag the border to 
resize the still image. 

Change the default 
number of still images 
printed per page. 

Click this to rotate the 
selected still image.

Click this to reset 
the layout.

Edit the Page Title
Open the [Edit] 
menu and select 
[Edit Header].

Change the Layout
Drag the still image 
to change the 
layout.

Click this to select a 
layout type.

Click this to display 
the Print dialog.

Add Text
Open the [Edit] 
menu and select 
[Add Text].

Add Captions to 
Still Images
Click the still image 
and then the [Edit] 
menu and select 
[Edit Caption].
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Printing Still Images (ImageBrowser)

Select this option to automatically 
correct only images shot with Exif 2.2 
compliant camcorders.

Select this option to automatically 
correct images shot with Exif 2.2 
compliant camcorders and 
other images.

A check mark must be placed 
here to automatically correct 
the image quality.

Mac OS 9.0-9.2

Adjusting Image Quality and Printing (Exif 2.2 Compliant)
ImageBrowser allows you to print images with image quality adjustments.
ImageBrowser also supports the Exif 2.2 standard (or Exif Print).

❍ Still images shot with camcorders complying with the Exif 2.2 standard
incorporate shooting settings information, such as the shooting
conditions and scene mode, along with the image data. The Exif Print
adjustment protocol uses this information to correct the image quality
more accurately to reflect the shooting settings.

❍ When printing from ImageBrowser, the image quality adjustment
settings are active for all still images.

1. Click the [Edit] menu in ImageBrowser and select
[Preferences].

2. In the Preferences window, select [Print], set the image
quality settings and click [OK].
See Printing Still Images for the next steps (  113).
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[Preferences].

2. In the [Preferences] window, select [Print], set the image
quality settings and click [OK].
See Printing Still Images for the next steps (  113).

Select this option to automatically 
correct only images shot with Exif 
2.2 compliant camcorders.

Select this option to automatically 
correct images shot with Exif 2.2 
compliant camcorders and other 
images.

A check mark must be placed 
here to automatically correct 
the image quality.

Mac OS X (version 10.1/10.2)
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Selecting the Print Mode and Number of Copies (DPOF Print Settings)
You can select the image and the number of print (  print settings) for
automatic printing on a DPOF*-compliant printer. You can set the DPOF print
settings also on the camcorder.
*Digital Print Order Format

When you are using a SD memory card, make sure the protect switch is
set to allow recording.

The Edit Slide/DPOF window allows print settings on up to 998 still
images. With some camcorders, DPOF print settings are limited to a
maximum of 200 still images. In that case, all DPOF print settings on the
201st still image and onward will be erased.

1. Click  (SLIDE/DPOF) in the Camera Window.
The Edit Slide/DPOF window appears.

2. Select the still image you wish to print and the number of
copies.
• [Standard Print]: Prints selected images in the specified number of copies.

Use the arrows next to the boxes below the image to select the number
of copies.

• [Index Print] and the option [Titles] of the [Edit] menu (printing of date
and file number) are not supported by the camcorder.

3. Click [Save to Camera].
The DPOF print settings will be saved to the memory card.

Printing Still Images (ImageBrowser)



M
ac

in
to

sh

119

E
You can merge a series of overlapping images into a single, seamless panorama.
PhotoStitch automatically arranges still images recorded with the camcorder’s
Stitch Assist mode in their correct order and orientation, making it easy to
merge them. Please refer to the Camcorder Instruction Manual to learn how to
record in Stitch Assist mode.
The following instruction explains how to merge still images recorded in Stitch
Assist mode with the camcorder.

Still images recorded in Stitch Assist mode with Wide-converter or Tele-
converter attached cannot be merged correctly.

1. Click the green stitch mark in the Camera Window.

2. In the confirmation window, click [Yes].
PhotoStitch starts.

Merging Panoramic Images (PhotoStitch)

Still images recorded with the 
camcorder's Stitch Assist mode
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3. Arrange the order of the images and click [2.Merge].
Operational instructions are displayed in the upper section of the window.

4. Click [Start].

5. Select [3. Save] and then click [Save].
• Select the destination folder, input the file name and click [Save].
• In the View the Saved Image? window, click [Yes]. The Viewer window

opens and displays the merged image.

❍ You can record the surroundings in 360 degrees, and stitch them
together later to form a 360-degrees cylinder. (In [1. Selection and
Arrangement], select [Arrange] and [360 degrees].) By saving this
stitched image in QuickTime VR format, you can then get a virtual
view of the surroundings by manipulating the mouse.

❍ For more details, please refer to the PhotoStich Help menu.

Merging Panoramic Images (PhotoStitch)
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You can change the size, resolution or file format of selected still images. You
can also export selected movie and still image information to a text file, or copy
and rename movies and still images.

1. Select images in the Browser Area.

2. From the [Edit] menu, select [Write a still image].

3. Select the export type and click [Next].
• [Resave the image]: Converts still images to another file format, resizes

and saves them as new files. You can select the file format from JPEG,
PICT, TIFF, and BMP. You can also specify a prefix to be added to the
exported images.

• [Write the image info]: Exports selected movie and still image information
to a text file.

• [Rename the file and copy]: Renames and copies selected movies and still
images. You can also specify a prefix to be added to the exported images.

Exporting Images
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4. Specify the export settings and click [Finish].
The options for the export settings vary according to the export type. Follow
the instructions displayed in the window. In each case, specify the
destination folder and file name for the images to be exported.

Exporting Images
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You can add still images from the computer to a memory card. You can also add
sample images for card mix from the DIGITAL VIDEO SOLUTION DISK For Macintosh.

❍ Still images in EXIF-JPEG, TIFF, PICT, and Windows bitmap format can
be added to a memory card. However, the still images will be saved in
JPEG format on the memory card.

❍ You can also add still images to a memory card by using drag and drop
to move it from the browser area to the Camera window.

Adding Still Images to the Memory Card

1. In the Camera Window, click [UPLOAD].

2. Select the still image you wish to add and click [Open].
You can check the selected still image.
Mac OS 9.0-9.2: Click [Show Preview].
Mac OS X (version 10.1/10.2): Click the file name.

Adding Still Images from Your Computer to the Memory Card
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Adding Still Images from Your Computer to the Memory Card

Adding Sample Images to the Memory Card
You can add sample images for card mix and card animation to the memory
card. 4 images for CARD CHROMA, 2 images for CARD LUMINANCE, 2 images
for CAMERA CHROMA and 4 images for CARD ANIMATION are provided on the
DIGITAL VIDEO SOLUTION DISK For Macintosh.

1. Insert the DIGITAL VIDEO SOLUTION DISK For Macintosh to
the computer’s CD-ROM drive.

2. In the Camera Window, click [UPLOAD].

3. In the Add Image window, select the image size and click
[Add].
• The selected images will be recorded to the memory card.
• When recording is complete, the images will appear in the Camera

Window.
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3. Double-click the CD-ROM icon, followed by the [DVC CARD

IMAGE] folder.
The folders [CARD CHROMA], [CARD LUMINANCE], [CAMERA CHROMA]
or [CARD ANIMATION] appear.

4. Open the [CARD CHROMA], [CARD LUMINANCE], [CAMERA
CHROMA] or [CARD ANIMATION] folder, select the image you
wish to copy to the camcorder and click [Open].

5. In the Add Image window, click [Add].
• The selected images will be recorded to the memory card.
• When recording is complete, the images will appear in the Camera

Window.
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The start-up image, start-up sound, operation sound, self-timer sound and
shutter sound are called the My Camera Settings.
ImageBrowser already contains several My Camera Settings which can be
selected in theme sets or individually. The “Animal” theme, for example features
and animal in the start-up image and animal calls in each of the sound files. The
files all begin with the same word (e.g. “Animal”, “Baseball”).
You can use the pre-recorded My Camera Settings (  129) or add still images
to the My Camera Settings (  130).

Observe following precautions while the My Camera Settings are saved to
the camcorder.
• Do not open the memory card cover or remove the memory card.
• Do not detach the USB cable.
• Do not turn off the camcorder or computer.
• Do not change the position of the POWER switch or TAPE/CARD switch.

Displaying the My Camera Window

1. From the [Edit] menu in the Browser Window, select [My
Camera].
The Select My Camera window appears.

Customizing Your Camcorder with the My Camera Settings
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2. Select [Start-up Image, Start-up Sound, Operation Sound,

Selftimer Sound and Shutter Sound] and click [OK].

3. Click [View Camera] to display the My Camera Settings of the
camcorder.

Alternatively, you can display the My Camera window from the Camera
Window by clicking [SETUP OPTIONS] and selecting [My Camera] from
the displayed menu.
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My Camera Window

Selects the type
of the My Camera
Settings.

Displays the 
My Camera 
Settings of 
the camcorder.

Saves the setting of the 
camcorder to the computer.

Displays the
My Camera 
Settings saved
on the 
computer.

Adds an image /
sound file to 
the [Computer]
list.

Plays back the
sound setting 
selected in the 
[Computer] list.

Plays back the sound setting 
selected in the [Camera] list.

Deletes a setting
from the 
[Camera] list.

Saves the setting from the 
computer to the camcorder.

Deletes a setting 
from the 
[Computer] list.

Saves the setting
from the 
camcorder to
the computer.

Customizing Your Camcorder with the My Camera Settings
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Saving the My Camera Settings to the Camcorder

1. In the My Camera window, select the theme set you wish to
save to the camcorder in the [Computer] list.
• To change the settings individually, select the setting type in the [Type] list.
• A window appears when you select a theme set and plays back the start-

up, operation, selftimer and shutter sound.

2. Select the setting you wish to replace in the [Camera] list and
click  .

3. On the confirmation window, click [OK].

4. Click [Save to Camera].
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5. On the confirmation window, click [OK].
• The selected setting replaces the old setting and appears in the [Camera]

list.
• If you wish to use this setting on the camcorder, change the My Camera

Setting on the camcorder itself. Refer to the Camcorder Instruction
Manual for details.

Adding Still Images to the My Camera Window

❍ To use still images recorded with your camcorder, you need to
download them to the computer before you can add them to the My
Camera Window.

❍ Sound cannot be added.

1. In the My Camera window, select [Start-up Image] in the
[Type] list and click [Add].
The [Select an image to add] window appears.

2. Select the still image file (JPEG) you wish to add and click
[Open].
The selected file appears in the [Computer] list. You can now save the newly
added file to the camcorder using the procedures described in Saving the
My Camera Settings to the Camcorder (  129).

To delete a setting, select the file and click the [Send to Trash] button
below the [Computer] list.

Customizing Your Camcorder with the My Camera Settings



M
ac

in
to

sh

131

E
Uninstall the software when you wish to delete it from your computer or when
reinstallation is required to fix corrupted files.

Uninstalling ImageBrowser and PhotoStitch
Move the program’s folder into the Trash to uninstall programs such as
ImageBrowser and PhotoStitch.

❍ If the program folders contain subfolders into which images have been
saved, be careful not to accidentally delete those subfolders.

❍ For more details on how to uninstall ImageBrowser, refer to Read Me.

Uninstalling the Software
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Connection

? Camcorder is not recognized when connected to the
computer.

➜ Computer does not support the USB interface.
The USB interface is not supported for computer not in compliance with the
following requirements. Acquire the necessary system to use the USB
interface.
Requirements: Genuine Apple Computer brand computer with a built-in USB
interface.

➜ There is no memory card in the camcorder.
Insert a memory card into the camcorder.

➜ The camcorder is not set to the correct mode.
Turn the POWER switch to PLAY (VCR) and move the TAPE/CARD switch to
CARD.

➜ Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer (  91) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

➜ If you are experiencing operational problems, detach the USB cable
from the camcorder and computer and terminate the connection.
Restart the computer and then reconnect the camcorder.

ImageBrowser Operation

? Cannot download images

➜ The camcorder it not set to the correct mode.
Turn the POWER switch to PLAY (VCR) and move the TAPE/CARD switch to
CARD.

? Image files or folders do not appear in ImageBrowser.

➜ Images of folders shown in ImageBrowser and the actual file
contents may be different.
Click the [View] menu and select [Refresh].

Troubleshooting
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